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ALBUQUERQUE AREA 12 FEDERAL LOCATIONS

2



OBJECTIVE
TRAIN STAFF AND PROVIDE BEST PRACTICES FOR 
MANAGING COLLECTION BATCHES
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ALBUQUERQUE AREA OFFICE
DAILY REPORTS FOR BATCHING

 PINACLE/ PNC BANK – DAILY EDI REMITTANCE PAYMENTS & LOCKBOX PAYMENTS
 CURRENT DAY SUMMARY AND DETAIL REPORT (PDF)
 EDI RECEVIED ITEMS DOWNLOAD REPORT FROM CSV FILE INTO EXCEL SHEET
 DOWNLOAD EACH LOCKBOX LOCATION ONTO ONE EXCEL SHEET
 SAVE LOCKBOX CHECK IMAGES

 COLLECTIONS INFORMATION REPOSITORY (CIR)
 DAILY TREASURY DEPOSIT NUMBERS & DEBITS
 DOWNLOAD VOUCHER REPORT  INTO PDF & CSV FILES INTO EXCEL SHEET

 EDI EXCEL SPREADSHEET & LOCKBOX EXCEL SPREEDSHEET INTO PIVOT TABLE
 EDI BATCHING INTO RPMS FOR POSTING
 LOCKBOX BATCHING INTO RPMS FOR POSTING
 SU PNC Listing
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PINACLE/ PNC BANK REPORTS 
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1. INFORMATION 
REPORTING TAB

2. STANDARD
3. SUMMARY AND DETAIL

SAVE THE CUR  
DAY SUMMARY  

DETAIL REPORT  



PINACLE/ PNC EDI 

6

1. Click on Special Reports Tab

2. EDI Received Items

3. EDI – Received Items
• Click on Export 

Remittance Data 
• Download, retrieve EDI 

from downloads, 
convert csv to excel.

• Save as: 
Srs_edi_summary_remitt
ance_export_current day 

date



PINACLE/ PNC LOCKBOX
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  ON 
ED 
S TAB

EB PAGE

3. VIEW DETAIL 
SPREEDSHEET

HIT OK TO 
DOWNLOAD 

TRANSACTION 
DETAIL TO YOUR 

DISK AS A CSV 
FILE. CONVERT 

TO EXEL

4. Save detail report as: Lockbox Output_date. Once Lockbox report is 
saved Copy & paste into 1 excel sheet for all Lockbox locations. 

5. Under Batch 
Numbers: hit 
the 1 to into 

Check Images

6. Printable Batch PDF is 
where you will save each 
Locations Lockbox Check 
Images. 



COLLECTIONS INFORMATION REPOSITORY 
(CIR)
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1. Voucher Report_V2

2. Documents

You can mark the Voucher 
Report_V2 as a favorite  to 

your dashboard

If you click on 2. Previous Business Day this 
will open up to  different Business Date 
Period to choose from. 

When you run the report. The CIR will bring up Treasury Deposit    
Lockbox and EDI deposits from PNC Bank. 



COLLECTIONS INFORMATION 
REPOSITORY (CIR)
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1. Next click on the 3 dots to save the CIR report in PDF & CSV file to 
export to into Excel. 

2. Select PDF  and Export. Save as: Voucher 
Report_V2_date. 

3. Select CSV and click on Data, then export. Save CIR report 
into excel and Save as: Voucher Report_V2_date. 

Bottom right corner is where the 
Export button is
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EDI REPORT RAW IMAGEEDI REPORT RAW IMAGE
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Service Unit PNC Listings
Finance request that all service unit locations send in their daily downloads to Area Finance. 

 This lets finance know where to batch payments under. Ex. Medicaid/ Medicare/ Private Insurance / Other. 

If checks numbers need to revised, finance will update the payments so the Service Units can auto post. 

The payor name/ insurance company needs to be revised the Service Unit will let finance know what payor
name/ insurance company to batch under. 

 Service units can email in a excel sheet or by letting us know in an email. 
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Current Day Reporting
Make sure your EDI report and CDR report match the ACH credit amount and items. 

Do not include the header, the first line.
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Revising the EDI spreadsheet:
1. Highlight Column J. Change the cell format to: TEXT

2. Find Cell L1. Highlight the 2nd Reference word

3. Change the 2nd Reference word to Number
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4. Need to insert 3 columns between P through R.

5. Once the 3 columns are inserted. 
◦ a. Column P Header Title is: Schedule
◦ b. Column Q Header Title is: Payor Type
◦ c. Column R Header Title is: MOS (month)

Revising the EDI spreadsheet:Revising the EDI spreadsheet:
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6. Find Cell Y1. Highlight in the word AMT

7. Change the word Amt to Amount

Revising the EDI spreadsheet:
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 Columns J, M, O, P and Q will be the ones to be simultaneously updating. 
Column J: Trace Number, is where you update the check number with CDR or with the SU PNC Listing. Change the 

whole column to TEXT under the HOME tab.

 Column M: Payee, is where you will put the SU location with using the CDR. CDR will  give you the name of the SU, Tax 
ID or a NPI # to identify who the payment belongs to. 

Review/ Updating the EDI Report spreadsheet 

CDR: SU LOCATION CDR: TAX ID

CDR: NPI #
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 Column O: Payor, is the insurance that is paying. You can update the Payor name with SU PNC Listing if the 
SU wants you to batch using a different payor name. 

EDI Report

SU PNC Listing

Review/ Updating the EDI Report spreadsheet 
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Review/ Updating the EDI Report spreadsheet 

 Column P: Schedule, where you assign the TDN with using the CIR. Once you get through the EDI  
report with identifying all the SU locations payments you match Column C with the payment amount 
with the CIR. Copy the TDN and past to column P and drag down.
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 Column Q: Payor Type, finance has a payor listing & formula that we use to assign if the payment is Medicaid, Medicare, 
Private Insurance, VA or Other. This is where the PNC listing plays an important role. The SU are letting finance know where to 
batch payments under. 

 Finance payor formula ties with column G (Company ID). You will add a sheet 2 into the EDI report. Sheet 2 has the listing of Payor names/ Insurance 
companies that finance has got from PNC bank over the years. Sheet 2 listing you will get from previous EDI report from the day before each time. 

Review/ Updating the EDI Report spreadsheet 

Column G reflects to Column A 
when sheet 2 is added
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Review/ Updating the EDI Report spreadsheet 

 Column Q: After sheet 2 is added with the payor listing. Finance will copy and past the payor formula which is highlighted 
below from the previous EDI report from the day before onto the EDI report into Column Q for current day.



Once payor formula is added you drag the payor formula down to last payment that is on the EDI report. 
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 Column Q: Now that you have your Payor Type and have received the SU PNC listing. You can now update 
where the SU wants the payment batched under. 

Review/ Updating the EDI Report spreadsheet 
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Last Column that needs to be update will be Column R, MOS. Just add the abbreviated month 
and drag down to the last payment on the EDI report. 

Review/ Updating the EDI Report spreadsheet 
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Review/ Updating the EDI Report spreadsheet 
 This is what the EDI report should look like after:
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PIVOT TABLE
 Need to create a pivot table to complete the EDI report. Pivot table can be found under the Insert Tab. 
Click on Pivot table and OK button. Highlighted below
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PIVOT TABLE
 Pivot Table Fields in order will be: 
 PAYMENT AMOUNT
 SCHEDULE (TDN)
PAYEE
PAYOR TYPE
PAYOR
TRACE NUMBER
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PIVOT TABLE
 The Pivot table will create a sheet 3. If any changes need to be update you still have to make the changes 
on the EDI report, which is now in the middle of sheet 3 & sheet 2. Any updates made on the EDI report, 
go back to the Pivot table and hit the Refresh All button under the Data tab to show the updates. 
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EDI Report is ready for batching
 EDI payments are ready to be batched into RPMS for SU to start posting. 
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Lockbox Report
 Saving the Lockbox report as shown on Slide 7. Once you have copied and pasted all the SU 
that had incoming payments from the Integrated Receivable tab in Pinacle/ PNC bank, can revise 
the Lockbox report. 

1. Delete the first two rows. 
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Revising the Lockbox Report:
2. Column N: Check Numbers, change the column to Text under the Home tab. Highlighted below

3. Column O: Change Header Title to Payor
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3. Need to insert 3 columns between P through R.

4. Once the 3 columns are inserted.
◦ a. Column P Header Title is: Schedule
◦ b. Column Q Header Title is: Payor Type
◦ c. Column R Header Title is: MOS (month) 

Revising the Lockbox Report:
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Review/ Updating the Lockbox Report spreadsheet

 Columns N, O, P and Q will be the to be simultaneously updated. 

 Column N: Check Number, is where you update check number with SU PNC listing.

 Column O: Payor, is the insurance that is paying. You can update the Payor name with SU PNC Listing if the 
SU wants you to batch using a different payor name

Lockbox

SU PNC listing
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Review/ Updating the Lockbox Report spreadsheet
 Column P: Schedule, where you assign the TDN with using the CIR. Once you get through the Lockbox report with 

their Lockbox # you will match Colum K with the payment amount with the CIR. Copy the TDN and past to column P. 
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Review/ Updated the Lockbox Report spreadsheet
 Column Q: Payor Type, finance has a payor listing & formula that we use to assign if the payment is Medicaid, Medicare, 

Private Insurance, VA or Other. This is where the PNC listing plays an important role. The SU are letting finance know where 
to batch payments under. 
 Just like the EDI report you add a sheet 2 and get the payor listing from the day before Lockbox report and the payor

formula. (Slide 19 & 20)
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Review/ Updating the Lockbox Report spreadsheet

 Last Column that needs to be updated will be Column R, MOS. Just add the abbreviated month and 
drag down to the last payment on the Lockbox report. 

 Lockbox report is complete
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PIVOT TABLE
 Need to create a pivot table to complete the Lockbox report. Pivot table can be found under the Insert 
Tab. Click on Pivot table and OK button. Highlighted below
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PIVOT TABLE
 Pivot Table Fields in order will be: 
 SCHEDULE (TDN)
 LOCKBOX
 PAYOR TYPE
 PAYOR
 CHECK NUMBER
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PIVOT TABLE
 The Pivot table will create a sheet 3. If any changes need to be update you still have to make the changes 
on the Lockbox report, which is now in the middle of sheet 3 & sheet 2. Any updates made on the EDI 
report, go back to the Pivot table and hit the Refresh All button under the Data tab to show the updates. 
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Lockbox Report is ready for batching
 Lockbox payments are ready to be batched into RPMS for SU to start posting
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AAO CENTRALIZED RPMS BATCHING

MAIN SCREEN WHEN LOGGING 
INTO RPMS. 
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RPMS Batching
 BAR  A/R MASTER MENU

 COL  COLLECTION MENU

 EN   COLLECTIONS ENTRY
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Entering Collection Batches
 Opening a Collection Batch. Use your EDI/ Lockbox report using the Pivot Table sheet.

 EDI/ Lockbox Pivot table will let you know what collection batch to open. 
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 ENTER TDN/ IPAC: COPY & PASTE FROM EDI/ LOCKBOX PIVOT TABLE

 ENTER TDN/ IPAC/ DEPOSIT DATE: DEPOSIT DATE 

 ENTER TDN/ IPAC/ DOLLAR AMOUNT FOR THIS BATCH: THE BATCH GRAND TOTAL

 CORRECT? YES// Here you can edit the collection batch if data was enter incorrectly

Entering Collection Batches

TDN #
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 PAYMENT TYPE: 51 (always be 51)

 PAYOR: Type in the name of the payor ( Allwell)

 SELECT THE PAYOR

Entering Collection Batches
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 CHECK/ EFT #: Copy & paste the check number that is on the EDI/ Lockbox pivot table

 CHECK BANK NUMBER: Hit enter you doesn’t need a entry

 CREDIT: Enter the dollar amount of the payment $

Entering Collection Batches
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Entering Collection Batches
 This page is check if you entered in the correct Payor, Check Number and Amount Paid. Make 
sure you have what is on the EDI/ Lockbox Pivot table. Before you enter in another payment.
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Entering Collection Batches
 All payment have been entered in the collection batch you can QUIT the collection batch.
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Finalizing Collection Batches
 CR  COLLECTIONS REPORTS

 FL  COLLECTION REPORT FINAL. Hit Space Enter and your collection batch that you were just in will pop 
up. 

 ENTER YES TO FINALIZE BATCH
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Finalizing Collection Batches
 DEVICE: SLAVE. Print collection batch
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Completed Batches
 Once all collection batches have been entered. Collection batches get scanned and Supervisor 
will check to make sure AR tech has match with the EDI/ Lockbox and with CIR. Supervisor will 
sign-off on the collection batches. 
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